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Introduction
 Photoshop CS6 used for this workshop.
 Newer versions should operate in a similar manner

but with added capabilities.

 There are many ways to do things in

Photoshop. These notes cover just one users
way.
 YouTube has loads of videos for help
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Useful keyboard shortcuts
 <Ctrl> + to zoom in
 <Ctrl> - to zoom out
 Or hold down <Alt> and rotate the mouse scroll wheel to zoom in or









out.
Hold down space bar to pan a zoomed area without coming out of the
selected tool
<Ctrl> D for Deselection
Use ] to increase a brush size
Use [ to decrease a brush size
Shift click a mask icon to disable it or to re-enable it
Alt click a mask icon to display the mask in the main image window.
Alt click the mask again to revert to the normal image display
To invert a layer mask use <Ctrl> I
To copy a selection to a new layer use <Ctrl> J

Note:
These workshop notes are written for a windows PC user
For Mac users use
the <Cmd > key instead of the <Ctrl> key.
<Ctrl> click instead of right click
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Opening images and preparations
 Open up the image to be worked on in Photoshop
 By default this will loaded as the Background layer
 Duplicate and rename the background layer

(The benefit is that you will always have the starting
image available if anything goes wrong. In addition some
Photoshop tools do not work on the background layer.)
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Right click the Background layer
Select <Duplicate Layer>
Add a new name as appropriate and hit OK
Click on the eye symbol on the background layer to switch it off.

Tool reset tip
 If a tool in Photoshop is not performing as expected.

E.g. you watch a YouTube video but your tool does
something a bit different you may need to reset your
tool to the default settings.
 To do this select the tool you want to use in the tools
palette. E.g. Magnetic Lasso Tool
 Right click on the tool icon at top left and select Reset
Tool
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Displaying the Properties panel
 The Properties panel is useful to show

the properties of an adjustment layer.
 If it is not displayed you can make it
visible in the following way



Select <Window> <Properties>
You can also drag it to a better location in
the right panel if you wish by grabbing the
title bar.
 When you select an adjustment layer the
properties will be displayed.
E.g. The mask in the example given.
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Selections - Introduction
 Why make selections?
 To isolate an area of an image so that you can do any

of the following:
 Confine actions to the selection. E.g. curves, levels etc.
 Create a layer mask from the selection
 Copy the selection and move it
 Copy the selection to a new
layer. <Ctrl> J
 Use the move tool

 Copy the selection to another
image
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Quick selection tool
 Select the Quick Selection tool in the

Tool palette

 The tool works by making selections

based on colour and texture similarity.
 Adjust the brush size to suit the selection
you want to make. You can change this as
you refine the selection. Start with the
largest size.
 Paint over the area to be selected and you
will see the marching ants appearing.
 You can automatically select several areas
of the image as the tool changes to “add to
selection” automatically
 If you want to remove some of the selection
change the mode to “subtract from
selection” by clicking the – brush tool icon
or using the <Alt> key.
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Lasso tools 1
 Lasso tool (best for chaotic

and random selections)

 Freehand draw whilst holding down





the left mouse button.
Shift key to add to selection
Alt key to subtract from selection
Or can use the buttons highlighted above
to add to or subtract from the selection
Hold down Alt key to switch between
regular and polygonal lasso tool and
vice versa

 Polygonal Lasso tool ( best for objects with straight

edges)

 Operates in the same way as the Lasso tool above
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Lasso tools 2
 Magnetic Lasso tool (best for irregular shaped objects with well

defined edges)

 Don’t have to click each point
 Left click to start and then just trace around the shape without clicking

until you are back at the start. The cursor will change from a + to a 0.
Click to complete the selection.
 Controls
 Frequency – how many points to lay
down.
(high value gives lots of points but
can result in a jagged edge)
 Contrast – how strong an edge
it is looking for
 Width – how far from the edge
can you go
 Any errors in the selection can be

corrected with the add to or subtract
from selection tools
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Pen tool 1
 The most precise selections can be made with

the Pen Tool.

 Zoom in to make the selection clearer
 Select the Pen tool from the tools palette
 Start tracing around the object to be selected,
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clicking at each point.
If you click in the wrong place you can use Backspace
to delete the last point
To create a curved line between the current point and
the last point hold down the left mouse button and
drag. You will see two bars appear at each end of the
section. Move around until the curve matches the
edge of the object.
You can go back and add a new point between two
old points to refine the shape.
Complete the path by clicking on the starting point.
The cursor changes to include a O when you are on
top of the starting point.
The path changes from a series of points to a faint
continuous line.

Pen tool 2
 To convert the path to a selection:


Hit the <Selection…> button at the top of the screen.







For a sharp edge leave the radius at zero.
Under Operation check New Selection is selected.
Hit OK
You should now have a selection with marching ants.

You can modify the selection by adding or removing parts
 To remove parts
 Use the pen tool again, as described earlier, to create a path
around the area to be removed
 Hit the <Selection…> button again and this time select the
Subtract from Selection option. Hit OK
 You should now see a modified selection with the part
removed.

 To add parts
 Repeat the above but this time select the Add to Selection
option

 To copy the selection to a new layer
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Use <Layer> <New> <Layer via Copy>
Or just hit <Ctrl> J

Rectangular / Elliptical Marquee tool
 Best for regular shapes
 Rectangular marquee Tool


Drag with the mouse button to create a
rectangular selection
 Hold down shift to create a square
 Hold down Alt to drag out a marquee from its
centre
 Hold down Shift + Alt to drag out a square from
its centre
 Use Shift and drag to add to
selection (+)
 Use Alt and drag to subtract from selection (-)

 Elliptical Marquee Tool


Similar operation to rectangular tool
 Hold down shift to create a circle
 Hold down Alt to drag out an ellipse from its
centre or Shift + Alt to create a circle from its
centre.
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Magic Wand tool




Select the Magic Wand tool in the Tool palette
The tool works by making selections within a similar
colour range with one click.


The tool has several adjustment controls
 Sample Size – Used to set the number of pixels averaged
to determine the colour to be selected.
 Contiguous – If unticked all similar colours will be selected
in the image. If ticked then only adjacent areas of the
same colour will be selected
 Tolerance – 0-255, low values select very similar colours,
high values select a broader range.
 Anti-alias – when ticked a smoother edge results
 Sample All Layers – when ticked the tool will sample all
layers.
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The selection can be added to using <Shift) click or
subtracted from using <Alt> click.
Once the selection is completed the edge can be viewed
and refined using the <Refine Edge…> control. This is
discussed in detail later.
You can always modify the selection with any of the other
selection tools. E.g. Marquee tool to remove a large
rectangular section.

Color Range tool

 Very useful for selecting complex shapes against a

plain background.
 The colour selection tool can be activated in several
ways.


Method 1
 <Select> <Color Range…>
 Use the eye dropper tool to select colour that you want to mask
out.
 You can use the + and – eye droppers to add and remove from
the selection.
 Fuzziness – a low value restricts the choice to the specific colour
picked. A higher value broadens the colour window.
 Further fine tuning can be achieved by selecting the Localized
Color Clusters option and using the Range control to bring in
multiple colour clusters.
 In the Color Range window you can choose to view the selection
or the original image using the tick box at the bottom of the
window.
 You can also change the Preview view with the drop down
options at the bottom of the window.
 Hit OK when happy with the selection

 To convert the selection to a mask hit the Mask button at
the bottom of the layers Palette
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Color Range tool
 Method 2
 Hit the Add a Mask button at the bottom of the
layers Palette
 This will add an empty mask to the current layer and
the Mask properties will be displayed in the
Properties Window.
 Hit the <Color Range…> button
 The Color Range window will appear. You can then
select the required colours in exactly the same way
as Method 1 on the previous slide.
 In this example select the sky colour.
 You will need to select the Invert tick box to make
the sky invisible in the final mask.
 When you hit OK a mask is created.
 In this example the sky will be replaced.
 Open a new sky image
 Using the move tool drag the new sky image across
to the original image.
 Move the new sky layer down below the original
image layer
 Using the move tool drag the new sky into the best
position to finish the task.
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Correcting / enhancing selections
 For any of the previous methods

if you want to make fine
adjustments to the selection you
can always revert back to any of
the other tools to make
adjustments.
 E.g. initial selection with

rectangular marquee tool and then
adjustments made with quick
selection tool
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Selections – Refine Edge





When you have made a selection with any of the previous tools you
can refine the edge of the selection using the <Refine Edge…>
button in the tool controls area. It is also particularly useful for
refining difficult edges e.g. hair or fur.
With your selection active use the <Refine Edge…> button to bring
up the Refine Edge controls
Controls


View Mode




Adjust Edge controls







View: drop down menu to select various options
for showing the selection. Try the different options. The best choice will depend
on the image being edited. On Black works best in this example.
Smooth – increase the value to smooth out the selection edges.
Feather – Makes the edge of the selection softer or more fuzzy.
Contrast – sharpens the edge
Shift Edge – Can be use to shift the edge in or out from the original position. Can
be used to avoid halos.

Brush tools


If you click on the Refine Radius Tool button you can select from
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Refine Radius tool, which adds to and refines the selection or
Erase refinements tool, which removes parts of the selection

Most of the time you want to use the first option, Refine Radius Tool with the
Smart Radius selected.

With a suitable brush size selected and in the On Black view mode
paint over the edge of the selection . As you paint you will see the
detail in the edge starting to appear after each brush stroke.
When you have finished refining the selection if you tick the Show
Original box you can see how the selection compares to the original.

Selections – Refine Edge
 To complete the Refine Edge action you can

select from a number of options for outputting
the selection.
 Using the drop down selection box at the
bottom of the window you can choose from:
 Output to






Selection
Layer mask
New layer
New layer with layer mask

 To create a layer mask select the Output to

Layer Mask option and hit OK
 In the layers panel you will see the layer mask
icon appear.
19

Layer Mask principle
 White reveals

100% visible
 Black conceals 100% invisible
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Creating a layer mask
 In several of the previous examples

a layer mask has been created to
isolate elements of an image.
 You can create a layer mask at any
time from a selection by clicking on
the Add a Mask button at the
bottom of the layers panel.
 Once created the mask can be
refined using the <Mask Edge…>
control in the properties panel. This
will then open up the Refine Mask
Control which operates in the same
was a the Refine Edge controls
described earlier.
 You can show the layer mask in the
main window by Alt clicking the
layer mask icon. To revert to the
normal image view Alt click the
mask icon again.
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Free Transform
 Transformations can be applied to a complete

layer or a selection within a layer
 You cannot transform the background layer. You
have to change it to a normal layer first as shown
earlier.
 Example 1 – Transform a complete layer
 Select <Edit ><Free Transform> you will then see a

bounding box appear around the layer. Or use <Ctrl> T
 You can then drag any of the handles to change the size
and shape of the layer.
 Use Shift click on the corner handles to resize and maintain
the aspect ratio
 Use Control click to change the perspective of the layer
 If you move the cursor outside the bounding box you can
rotate the layer

 When you are happy with the transformation hit Return
or click the tick symbol on the top toolbar.
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Transform variations
 Other types of transformation are also available


When you have initiated a transformation as above by
selecting <Edit ><Free Transform> or <Ctrl> T
 Right click within the image to reveal all the different
transformation options. Or select via the <Edit><Transform>
menu.
 Scale – Allows you to grab any handle and move it as per
previous example
 Rotate – Rotates selected object around the rotation point
which is in the centre of the object by default but the rotation
point can be moved by dragging it or using the grid icon in the
toolbar.
 Skew – Effect as shown below
 Distort – Effect as shown below
 Perspective – Effect as shown below
 Warp - Effect as shown below


Hit Return or click the tick icon to confirm the transform.
Skew
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Distort

Perspective

Warp

Transforming objects
 Example 2 – adding a label to cylindrical object






Open both starting images.
In the label image select the label using the rectangular marquee tool
Create a layer mask by clicking the Add Layer Mask icon
Using the move tool drag the label across to the mug image and position
the right edge of the label in the correct position on the mug.
Select <Edit> <Transform> <Warp>
 Using the handles on the bounding box to warp transform the label as
appropriate to conform to the shape of the mug. This technique requires a lot of
trial and error at first.
 Once the label has been warped over the surface of the mug but with excess
label on the left hit Return or click the tick in the toolbar.
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The excess label can be removed by selecting the area to be removed with
the polygonal lasso tool and hitting the delete key.

Using the History Palette
 Allows you to step back through the editing process
 If the history panel is not visible it can be opened by

selecting <Window> <History>
or by hitting the history panel icon as highlighted
below
 You can jump back to any previous state
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Exploring Blending modes







Photoshop has a multitude of blending modes that can be applied to alter the
way layers are blended together. To cover these in any depth is beyond the
scope of this workshop.
However, a method will be introduced to explore the different modes and their
effects.
Choose a suitable image and a texture to experiment with.
Load both images into Photoshop
With the texture image active select the Move Tool.
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Holding down Shift drag the texture image into the main image and release the shift key.
(holding shift while moving ensures the image is centred in the second image.)
You now have the texture layer on top of the main image.

With the texture layer selected hold down Shift and use the + or – keys to cycle
through the different blending modes and see the effect on the underlying
image.
In this example Soft Light gave a reasonable effect.
To refine the effect select the texture layer and from the Filter Menu select
<Blur> < Gaussian Blur> and adjust to give the desired effect.
The Opacity control can be used to make the effect more subtle.

Blending two bracketed exposures
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Load the two images into Photoshop



Using the Move tool hold down the Shift key and drag the image with correct
foreground exposure into the other image. It will be copied over as a new layer.



You can rename the top layer as foreground by double clicking the Layer name and
typing the new name.



Click on the Foreground layer and Select the Lasso tool and make a selection of the
sky part of the image painting the line just below the horizon. The image on the
following page shows where the selection was made for this example.



With the selection finished and the marching ants visible create a layer mask by hitting
the Add a Mask button at the bottom of the layers Palette



You will notice that the foreground has gone dark. In the layer mask black represents
transparency. We actually need to invert the mask to get the correct blend. To invert
the mask select the Invert button in the Properties panel or use <Ctrl> + I



The resulting image will have the correct sky and foreground but the transition will be
very harsh.



To correct the mask select the <Mask Edge…> button in the Properties panel. This will
bring up the Refine Mask panel.
 Set the View control to On Layers
 Adjust the Feather control until you are happy with the transition between the
two layers. In this example the Feather worked best when set to about 160.



The blended image can be refined by using a curves adjustment layer and perhaps
some subtle dodging and burning if desired.

Making the sky selection

The precise position of the selection
line is not critical as it will be
feathered. It should however be drawn
below the horizon.
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Simulating a ND Grad filter in Photoshop Elements








Open the image
Reset foreground and background colours by clicking the
bottom left of the Color tool
Create new Gradient fill layer by clicking on the Create new
fill or adjustment layer button
From the menu list select Gradient…
In the gradient fill control panel set the gradient type to
Foreground to transparent
Tick the Reverse box for darker at the top
Position the gradient transition by dragging in the image








To make it easier to set the transition you can change the scale
control to 1. When the transition is in the desired position change
the scale control to the required value.
At the moment the image will look unnatural but it will show the
are to be darkened

Change layer blend mode to Soft light. This will revert the
image to a more normal look.
Use the Opacity slider to make fine adjustments to the
intensity of the filter
Save the image.

Note: This method will also apply to the full Photoshop version.
Although a better way is to use the grad filter tool in the Adobe
Camera Raw convertor or Lightroom.
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Focus stacking 1
In Macro photography the depth of field is usually very
shallow.
If you take a series of photographs where you selectively
focus at increasing or decreasing distances from the lens
you can combine the images using the Photoshop Focus
Stacking tool. The resulting image will look in focus from
the front to back of the focus range you have chosen.


Process all your starting images in the normal way and
place them in a folder.



To import the images into a stack in Photoshop perform
the following steps.
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From the <File> menu select <Scripts> <Load Files into
Stack>
Use the Browse button to navigate to where your starting
images are located and select them all
Tick the box to align the source images.
Hit the OK button
All the images will be loaded into Photoshop on separate
layers.

Focus stacking 2


Now the images have been loaded and aligned we
need to blend the images.
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Select all the layers by first clicking on the top layer and
then Shift clicking on the bottom layer
From the <Edit> menu select <Auto-Blend Layers…>
In the Auto-Blend Layers control box select the Stack
Images Blend Method
Also select the Seamless Tones … option
Hit the OK button
Photoshop has now created a layer mask for each layer to
bring out the in focus details in each layer
You can explore the different layers contribution by
clicking off the layers one by one clicking on the eye icons
on each layer

Transforming the Clone Source
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In this example we will use the crop tool to recover the blown highlights next to the
cats left eye by cloning from the similar position next to the cats right eye. But in order
to do this we need to be able to flip and rotate the clone tool.



Zoom in to show the area to be fixed and the area to be cloned from. (Alt + scroll
wheel)



Select the clone tool in the tools palette.



To transform the cloned selection we need to use the Clone Source controls. These can
be accessed from the Window menu and selecting Clone Source.



Select a soft brush of the right size for the area to be cloned from.



Position the brush on the are to be cloned from. Alt click and then move the brush to
the position to be healed. At this stage do not click the brush. You will be able to see
the copy of the source in the new position.



We need to change the orientation of the cloned image . In the Clone Source control
panel click the “Flip Horizontal” button. You should see the clone brush effect flipped
over.



To make a fine adjustment you may need to rotate the clone source slightly using the
angular control. If you click in the number field you can use the up and down arrow
keys to finely rotate the clone source. Use shift with the arrow keys to move the angle
in larger increments.



When you are happy with the transformation of the clone source you can paint in the
cloned area by holding down the left mouse button in the usual manner.



Save the changes

Creating Drop Shadows - basic





Start by making a selection of the object that requires a shadow.
Create a mask to isolate the object
Duplicate the layer
Add a new background colour wash


Use the Paint Bucket Tool and the Gradient Tool
 Use Black to White and Soft Light mode in the gradient tool




Select the layer that you want create a drop shadow from
From the fx button at the bottom of the layers palette select drop
shadow






Start with default settings (reset if necessary)
You can drag the shadow to make it visible
Set size to a small number to soften the edges
Hit OK
To move the shadow to its own layer
 Select <Layer> <Layer Style> <Create Layer>
You may get a warning but ignore it.



To change the perspective of the shadow
 <Edit> <Transform> <Distort>
 Using the grab handles change as required. Accept the changes.
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Creating Drop Shadows - refinements
 Save the shadow as a channel
 Select the shadow layer
 Open the channels palette
 From the palette menu select <New Channel>
 Name will be Alpha 1
 Check Color Indicates Selected Areas is selected.
 Hit OK

 Add a gradient to make the shadow fade
 With the Alpha 1 channel selected
 Select the Gradient tool in the tools Palette
 Set Black to White mode and linear gradient
 Mode Multiply and Opacity 100%
 Click and drag from furthest point to closest point of
shadow
 Select the RGB channel
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Creating Drop Shadows - refinements
 To add realistic blur to the shadow
 Select the shadow layer in the layers palette
 Select <Filter> <Blur> < Lens Blur>
 Check Depth Map Source is set to Alpha 1
 Set the radius to a value to give an acceptable level of blur at the
extreme of the shadow
 Hit OK
 To apply the gradient to the shadow
 Select the shadow layer
 Select <Select> <Load Selection>
 Change the channel to Alpha 1 and ensure New selection is ticked. Hit
OK
 Select <Select> <Inverse>
 Hit the Add Layer Mask button at the bottom of the layers palette.
 In the channels palette deselect Alpha 1 to remove the red cast
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